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INTRODUCTION
Welcome to WinShear32, the latest operating software for the Hercules® Hi‐Shear Viscometer
Model DV‐10. WinShearTM and WinShear32TM are copyrighted products of Kaltec Scientific, Inc.
(2011).

New Features
If you have previously used versions of WinShear, you will find that WinShear32 has much of
the same functionality but is much easier to use and customize.
Tabular menus to consolidate many of the software and graph settings into one easy to use
dialog.
The user can double click any saved test file (.vis file) from Windows Explorer to
automatically launch WinShear32 and have that file opened.
The diagnostics has been upgraded to aid in quick diagnosis in the even of a problem.
A password function has been added to prevent unauthorized viscometer calibrations.
Better viscometer to computer communications for automatic machine setup as well as
improved error detection when a test is interrupted.
Up to three customizable graphs can be displayed after a test is completed to show you
exactly the results you prefer to view.
The help file has been completely rewritten to provide the best source of information for
WinShear32’s operation, troubleshooting and capabilities.
And most importantly WinShear32 is now fully implemented as a Windows 32‐bit program,
which will allow up to 72 character file names as well as increased speed and functionality.

Minimum Computer Specifications








133 MHz Processor
32 MB of RAM
VGA Video Card
30 MB of Free Hard Disk Space
Windows 98
CD‐ROM Drive
1 available Serial Port or 1 USB Port with a key span model USA‐19HS USB
Serial Adapter
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Recommended Computer Specifications








Current Intel or AMD processor
128 MB of RAM
SVGA Video
1 GB Hard Disk
Windows XP
CD‐ROM Drive
1 available Serial Port or 1 USB Port with a key span model USA‐19H5 USB
Serial Adapter

Getting Help
You can find help for the WinShear32 software in this manual or by using the on‐line help in the
software.
You can also contact Kaltec’s Support Department by one of these means:
Telephone
248‐349‐8100

Facsimile
248‐349‐8909

Email
help@kaltecsci.com

WinShear32 and the Hercules® DV‐10 Viscometer are produced by:
Kaltec Scientific, Inc.
22425 Heslip Drive
Novi, Michigan 48375‐4138 USA

On-Line Help
This WinShear32 help file is organized much like the WinShear32 software menu. Double click a
menu topic to view the subtopics. The subtopics are the same; as you will find in the actual
WinShear32 software menu, double click a subtopic to learn more about its function.

Technical Support
Before contacting Kaltec’s Technical Support, it is advisable to have the following information
available.
Viscometer Serial Number
Software Version Number
Operating Environment (i.e. Windows XP)
Computer Specifications (i.e. 2.6 GHz, 256 RAM)
Exact wording of any messages that appear on your screen.
How and when the problem occurred.
Action taken to resolve the problem.
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Installing WinShear32
The WinShear32 CD should automatically start the installation program when you insert it into
the CD‐ROM. If you have the auto run capability turned off on your computer, you must follow
these procedures to start the installation.
1.
2.
3.
4.
5.

Insert the WinShear32 Software CD into the CD drive.
Click on START / MY COMPUTER
Double‐click on the CD drive the software is located.
Double‐click on SETUP.EXE
Follow the instructions on the screen.
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FILE MENU
Open
Opens an existing data file with the WinShear or WinShear32 extension (.vis) or the DOS
extension (.dat).
1.
2.
3.
4.

Choose Open from the File menu or click the quick
button.
Select the type of data file in the “Files of type:” box (Default is *.vis)
In the “Look in” box, click the drive that contains the data file.
In the box beneath “Look in” that lists folders and files, double‐click the name of the folder
that contains the data file. Continue double‐click subfolders until you open the subfolder
that contains the data file. Click the file you want to open or type its name in the “File
Name:” box.
5. Click Open or double‐click the filename to open.

Save
Saves the current data file. You will be prompted for a new name, if one doesn’t already exist.
1. Select Save from the File menu or click the quick
button. (If the test has all ready been
saved, this will automatically update the data file.)
2. To save the data file in a location other than the WinShear32 folder, click a different drive
name or folder name.
3. To save the data file in a new folder click on
.
4. In the “File Name” box, type the name for the new data file.
Naming Documents: To make it easier to find your data files, you can use long descriptive
filenames. The complete path to the file, including the drive letter, server name, folder
path, and filename, can contain up to 255 characters. Filenames cannot include any of the
following characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<),
asterisk (*), question mark (?), quotation mark (“), pipe symbol (|), colon (:), or semicolon
(;).
5. Choose Save.
If a dialog box appears warning you that you are about to overwrite an existing data file,
then a file by the same name already exists. If you choose Yes, you will replace the existing
file with the current data file. If you choose No, the Save command is ignored.
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Save As
“Save As” allows you to save the current data file that was previously saved under a different
name. You can also save data files in the previous version’s format.
1. Select Save As… from the File menu.
2. In the “File Name” box, type a new name for the data file.
3. Click Save.
Tip:

To save the copy in a different location, click a different drive or folder name. To save
the copy in a new folder, click

.

If a dialog box appears warning you that you are about to overwrite an existing data file, then a
file by the same name already exists. If you choose Yes, you will replace the existing file with
the current data file. If you choose No, the Save As command is ignored.
Note:

The program will automatically prompt you to save a test file, if:
A) the user try to run another test without saving the last test, or
B) the user attempts to exit WinShear32 without saving the last test.
You will have the option of “Yes” or “No” to save. If “Yes” is selected, the “Save As”
dialog will be shown.

Overlays
Overlays allow you to superimpose saved test data on the top of the graph of the current open
data set. Besides the original graph, a maximum of ten overlays can be added. Each overlay file
is represented by a different color and titled by the files Sample name, if one was entered at
the time the test was run.

Add Overlay
To select the data file to add to the current open data file.
1.
2.
3.
4.
5.
6.

Open or run a new test.
View the current data’s graph, by selecting “Show Graph” under the Graph option.
Select “Add Overlay” from the File menu; the Select Overlay File dialog appears.
Select the type of data file in the “Files of type:” box (Default is *.vis).
In the “Look in” box, click the drive that contains the data file.
In the box beneath “Look in” there is a list of folders and files, double‐click the name of the
folder that contains the data file. Continue double‐clicking subfolders until you open the
subfolder that contains the data file. Click the file you want to open or type its name in the
“File Name:” box.
7. Click Open or double‐click the filename to open. The overlay data appears in a different
color.
Note:

You cannot view the calculations, data, or test information of any overlay data set.

6

Remove Overlay…
Removes the overlay information from the graph(s) of the current data.
Note:

This option is only available after you have added an overlay.

1. Choose Remove Overlay from the File menu.
2. Select a file or files form the Remove Overlay dialog and click OK.
Note:

Clicking once on the filename selects it, clicking twice deselects it. You can remove
multiple overlay files.

Saving Overlays
Important Note: It is important to use the Save As option under the File menu. By choosing
Save, you will overwrite the original data file. (See Save As).

Print
Prints the active graph or report.
Note:

The Print dialog that appears for graphs is different from the one that appears for
tables. The dialog will also vary depending on the type of printer you are using.

1. Click on the table or graph you want to print. This makes that window active.
2. Choose Print from the File menu or click the quick
3. Select the options you want form the Print dialog.
4. Click OK.

button.

Exit
Selecting Exit from the File menu ends the current WinShear32 session. The program will
prompt you to save your current data file before exiting only if it has not been saved already.
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EDIT MENU
Copy
Highlight data or activate the graph window, select Copy. This will place a copy of your selection
on the Clipboard so that it may be placed in another program.
The quick

button performs the same function.

Annotations
Shows the procedure to add annotations to a graph, click OK to close the window.
1. Select a graph.
2. Hold the Alt key and click the left mouse button on the location of the graph that you want
to place the annotation.
3. Enter the annotation in the window then click OK.
To edit or remove an existing annotation, press the left mouse button while pointing at the
annotation.

Inserting a Calculation into the Annotation
1.
2.
3.
4.

Select the value in the Calculations dialog by clicking once on it.
Click the Copy button.
Do steps 1 and 2 for Annotations.
Click once in the annotation window to place the cursor, then hold the Ctrl key and press
the v key once.
5. Click OK.

Note:

Only one calculation at a time can be added as an annotation due to a size limitation.

Export
Exports the Graph or Test Data to the clipboard, a file, or a printer. You can transfer the graph
in different graphic formats, or choose to copy only text and data.
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1. Make the graph you want to export the active window
by clicking on it.
2. Choose Export from the Edit menu.
3. In the Export dialog that appears, choose the format
in which you want to export the graph and the
destination. Specify an object size, if applicable.

File formats available:
MetaFile (.wmf)
BitMap (.bmp)
Embedded Object (Automatically copies to the
Clipboard, then once in the other program PASTE
the graph.)
Text/Data Only (.txt/.dat) Selecting Text/Data Only
will open a second window with various options
and styles for exporting the data as text.
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VIEW MENU
Full Screen…
Expands the current graph so it covers the entire screen. Click the title bar or press the ESC key
to return to normal view.

Zoom In…
You can expand a particular section of the graph in order to see more detail.
1. While holding down the Shift key, click and drag diagonally to form a box over the area of
the graph you want to expand.
2. Release the mouse button. The graph will show the area you selected in more detail.
3. To return to the normal view, select Zoom Out from the View menu.

Zoom Out…
Returns the graph to the normal size, only if you have zoomed in on the graph.

Filter Data…
Filters the data to create a smoother graph line. This cannot be undone, but can be done
multiple times.

Data
Displays the raw data of the current test. The following values are displayed in a table format:
Data Points, RPM, Torque, and Temperature.
Note:

You can only have one data window displayed at a time.
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Calculations
WinShear32 uses the 700± data points collected with the test to produce various calculations.
WinShear32 calculates the following at peak RPM:
◊
◊
◊
◊
◊
◊
◊

Torque
Deflection
Apparent Viscosity
Shear Rate
Shear Stress
Start Temperature*
Leveling Index

◊
◊
◊
◊
◊
◊

Reynolds Number
Mechanical Energy
Rheogram Hysteresis Area
Kinematic Viscosity
Actual peak RPM
End Temperature*

* When the IR Temperature Sensor is being used.
Note:

You can only have one calculation window displayed at a time.

Viewing a Data Point’s Calculations
You can view the calculations for a particular point
on a graph.
1. Place the cursor over a point on the graph until
the mouse arrow changes to a hand.
2. Click the mouse button, the Data Point
Calculations dialog box appears.
3. Click OK when you are done viewing the
calculations.

Test Info
Displays the Test Info dialog, which shows the user parameters entered when the current data
set was created. The Change button opens the User Parameters window and allows you to
change only the Operator name, Sample name, and User input.
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Dilatant
Displays a table showing torque results at 1100, 2200, and 4400 RPM. Also shows the RPM
results at 1800 kilodynes of torque.

Shear Blocked
Designed to analyze the results of fluids which at low shear rates behave Newtonian at first, but
as the shear rate increases, the sample may suddenly become dilatant (blocked). An algorithm
is applied to the results to identify the break point (where the sample begins to Shear Block).
A table reports the following information:
Line 1: Torque and Apparent Viscosity at 4400 RPM
Line 2: RPM and Apparent Viscosity at 3600 kilodynes
Line 3: Identifies the Point and displays RPM, Torque and Apparent Viscosity

Options
This tabular menu has all the settings and options for WinShear32 to operate properly with
your DV‐10’s hardware configuration.

Software Tab
Comm Port

This displays which communication port the computer is using
to connect to the DV‐10. Only change this setting if you have
changed the computer’s connection or hardware.

Real Time Graph

Allows the graph to be updated more or less often while
running a test. The number refers to the number of data
points to skip between updates. Recommended setting is 7,
but a higher setting may be required if the computer is
running slow. To disable the Real Time Graph, change the
setting to zero.

Temperature Sensor

If you have the IR Temperature Sensor installed on this
viscometer, this box must be checked for it to operate and
show results in the software.

Machine Tab
Serial Number

Also found on the black ID tag on the DV‐10.

Spindle Ratio

Standard DV‐10’s (6600 maximum RPM) spindle ratio is 2:1.
The 8800 RPM Option has a spindle ratio of 3:1. The correct
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ratio must be entered in order for the DV‐10 to run at the
correct speed.
To visually confirm which spindle ratio to use, locate the
pulley on the top of the spindle housing. Count the number of
fasteners on the pulley. If you count 3, the spindle ratio is 2:1.
If you count 2, the ratio is 3:1. Note: If this setting is incorrect,
the DV‐10 will generate inaccurate data.
Firmware Version

Requires version 7.0 or higher for WinShear32 to work
properly.

Get Parameters

(For Firmware Version 8.0 or greater) By clicking on this
button, the software will communicate with the viscometer
and retrieve the serial number, spindle ratio and firmware
version.

Set Parameters

This will store all three values after a pop‐up warning stating,
“These settings must match the viscometer or your test
results may be incorrect.” Click OK to finish storing these
values.

Security Tab
The Security Tab allows you to assign a password to be required in order to perform a
calibration. This is used to prevent unauthorized calibrations. By default there is no password
set. With no password set the password dialog will still be shown when a calibration is run,
simply click OK to continue.

System Tab
Displays the Measurement System and Temperature Units dialog. This will tell you which
measurement system is currently being used and allows you to change it as well as the
Temperature Units. If you make a change, all displays will be updated.
1.
2.
3.
4.

SI = System International (same as MKS)
CGS = Centimeter‐Gram‐Second
MKS = Meter‐Kilogram‐Second
English = Foot‐Pound‐Second

Communications
This dialog will warn that the computer is not communicating with the DV‐10.
If you do not need WinShear32 to communicate with the DV‐10 then click Ignore. The Try Again
button will attempt to establish the communications again. The comm. Port box allows you to
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select your computer’s comm. Port from 1 to 4,
each time you change this value, click the Try
Again button to test it. When this dialog box goes
away then the communications are working.
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RUN MENU
Auto Test
The Auto Test activates a standard measurement cycle. The Bob speed will follow the
instruction set defined by the operator in the User Parameters dialog for the Auto Test.

Viscometer
1. Install the Cup into the Cup Holder, locking it into place by turning the Cup counterclockwise
until it stops.
2. Turn the selected Bob counterclockwise on to the Spindle. Rotate until the Bob is on finger
tight. Refer to the viscometer manual for more information.
3. Pour the sample into the Cup. The Bob you have chosen determines the amount of sample
used. Use the Fluid Depth Gauge to measure the correct amount. The Quick Cup has fill line
for the A bob scribed inside the Cup.)
4. Lower the Bob down into the Cup by turning the Spindle Levers towards you.

WinShear32
1. From the RUN Menu, select Auto Test.
Note:

The

button always displays the first user‐defined test.

2. Fill in the User Parameter’s fields.
Test Name:

Enter a brief description of the test.

Input Density:

Enter the density of the sample (0.001‐9.999). Use an external measuring
device for the density value in g/cm3. The density is used to calculate the
Kinematic viscosity of the sample.

Percent Solids:

Enter the percent of solids in the sample (0 to 100). This field is for the
operator’s use only. It is not used in any of the calculations.

Temperature:

If the temperature sensor is installed and turned on in the Options Setup,
the word “Auto” will be displayed. If the sensor is turned off in the
Options Setup, enter the temperature of the sample with the Bob
lowered into the Cup. (Temperature unit is setup in
View/Options/System, choices are Kelvin, Celsius (default), and
Fahrenheit.) This data is very important for repeatability and is saved
with the test file.

Operator Name:

Enter the person operating the viscometer.
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Sample Name:

Enter the name or code for the sample. This field will be displayed as the
title on graphs and printouts.

User Input:

This field is provided for the operator to write notes or comments about
the test.

Bob:

Select the Bob that is installed on the viscometer by using the pull‐down
menu. (Click the down arrow for the list of available Bobs.)

Spring Set:

The value can be 25 – 1000. This is used to scale the Standard Hercules
graph. It is represented in kilodynes on the torque axis.

Ramp to Max?:

Max RPM – If you select this option enter the desired maximum RPM (1‐
6600 on standard DV‐10s or 1‐8800 with the upgraded DV‐10s). The DV‐
10 will ramp down or stop after reaching the maximum RPM.
Shear Rate – If you select this option, enter the desired maximum Shear
Rate (1‐27,984 on standard DV‐10s or 1‐37,312 on upgraded DV‐10s). The
DV‐10 will ramp down or stop after reaching the maximum Shear Rate
unless the maximum RPM is reached first.
Max Torque – If you select this option, enter the desired maximum
Torque (1‐18,000 kilodyne‐cm) that should be exerted. The DV‐10 will
ramp down or stop after reaching the maximum Torque unless the
maximum RPM is reached first.
Shear Stress – If you select this option, enter the maximum Shear Stress
(1‐720,000 dynes/cm2) that should be exerted. The DV‐10 will ramp down
or stop after reaching the maximum Shear Stress unless the maximum
RPM is reached first.

After Max:

Ramp Down – By selecting this, the viscometer will ramp down after
reaching the maximum specified in the Ramp to Max.
Stop Immediately – The test will automatically stop when ramped to the
maximum specified in the Ramp to Max.

Pre‐Shear:

Number of times to run the machine with the listed parameters before
running an actual test. It will not produce data when running pre‐shear.

Ramp Time:

Time in seconds for the spindle to ramp up to the maximum RPM and
ramp back down to zero (0.1‐120 seconds). Default ramp time is 20.4
seconds.

Hold Time:

Enter the number of seconds (0‐999) that the test will hold when it has
reached the maximum specified in the Ramp to Max.

3. Click the Run button. This will start the testing process according to the parameters
entered. By default, the Standard Hercules graph (Torque vs. RPM) will be produced while
the viscometer is running.
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Trace Test
The Trace Test works exactly like the Auto Test, it activates a standard measurement cycle. The
Bob speed will follow the instruction set defined by the operator in the User Parameters for the
Trace Test.

Viscometer
1. Install the Cup into the Cup Holder, locking it into place by turning the Cup counterclockwise
until it stops.
2. Turn the selected Bob counterclockwise on to the Spindle. Rotate until the Bob is on finger
tight. Refer to the viscometer manual for more information.
3. Pour the sample into the Cup. The Bob you have chosen determines the amount of sample
used. Use the Fluid Depth Gauge to measure the correct amount. The Quick Cup has fill line
for the A bob scribed inside the Cup.)
4. Lower the Bob down into the Cup by turning the Spindle Levers towards you.

WinShear32
1. From the RUN Menu, select Trace Test.
Note:

The

button always displays the first user‐defined test.

2. Fill in the User Parameter’s fields.
Test Name:

Enter a brief description of the test.

Input Density:

Enter the density of the sample (0.001‐9.999). Use an external measuring
device for the density value in g/cm3. The density is used to calculate the
Kinematic viscosity of the sample.

Percent Solids:

Enter the percent of solids in the sample (0 to 100). This field is for the
operator’s use only. It is not used in any of the calculations.

Temperature:

If the temperature sensor is installed and turned on in the Options Setup,
the word “Auto” will be displayed. If the sensor is turned off in the
Options Setup, enter the temperature of the sample with the Bob
lowered into the Cup. (Temperature unit is setup in
View/Options/System, choices are Kelvin, Celsius (default), and
Fahrenheit.) This data is very important for repeatability and is saved
with the test file.

Operator Name:

Enter the person operating the viscometer.

Sample Name:

Enter the name or code for the sample. This field will be displayed as the
title on graphs and printouts.

User Input:

This field is provided for the operator to write notes or comments about
the test.
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Bob:

Select the Bob that is installed on the viscometer by using the pull‐down
menu. (Click the down arrow for the list of available Bobs.)

Spring Set:

The value can be 25 – 1000. This is used to scale the Standard Hercules
graph. It is represented in kilodynes on the torque axis.

Ramp to Max?:

Max RPM – If you select this option enter the desired maximum RPM (1‐
6600 on standard DV‐10s or 1‐8800 with the upgraded DV‐10s). The DV‐
10 will ramp down or stop after reaching the maximum RPM.
Shear Rate – If you select this option, enter the desired maximum Shear
Rate (1‐27,984 on standard DV‐10s or 1‐37,312 on upgraded DV‐10s). The
DV‐10 will ramp down or stop after reaching the maximum Shear Rate
unless the maximum RPM is reached first.
Max Torque – If you select this option, enter the desired maximum
Torque (1‐18,000 kilodyne‐cm) that should be exerted. The DV‐10 will
ramp down or stop after reaching the maximum Torque unless the
maximum RPM is reached first.
Shear Stress – If you select this option, enter the maximum Shear Stress
(1‐720,000 dynes/cm2) that should be exerted. The DV‐10 will ramp down
or stop after reaching the maximum Shear Stress unless the maximum
RPM is reached first.

After Max:

Ramp Down – By selecting this, the viscometer will ramp down after
reaching the maximum specified in the Ramp to Max.
Stop Immediately – The test will automatically stop when ramped to the
maximum specified in the Ramp to Max.

Pre‐Shear:

Number of times to run the machine with the listed parameters before
running an actual test. It will not produce data when running pre‐shear.

Ramp Time:

Time in seconds for the spindle to ramp up to the maximum RPM and
ramp back down to zero (0.1‐120 seconds). Default ramp time is 20.4
seconds.

Hold Time:

Enter the number of seconds (0‐999) that the test will hold when it has
reached the maximum specified in the Ramp to Max.

3. Click the Run button. This will start the testing process according to the parameters
entered. By default, the Standard Hercules graph (Torque vs. RPM) will be produced while
the viscometer is running.
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User Test
This test is similar to the Auto Test, if activates a standard measurement cycle. The Bob speed
will follow the trajectory as defined in the User Parameters. However, when you enter the Test
Name it will appear in the RUN Option menu. There are eight User Tests available.

Viscometer
1. Install the Cup into the Cup Holder, locking it into place by turning the Cup counterclockwise
until it stops.
2. Turn the selected Bob counterclockwise on to the Spindle. Rotate until the Bob is on finger
tight. Refer to the viscometer manual for more information.
3. Pour the sample into the Cup. The Bob you have chosen determines the amount of sample
used. Use the Fluid Depth Gauge to measure the correct amount. The Quick Cup has fill line
for the A bob scribed inside the Cup.)
4. Lower the Bob down into the Cup by turning the Spindle Levers towards you.

WinShear32
1. From the RUN Menu, select User Test.
Note:

The

button always displays the first user‐defined test.

2. Fill in the User Parameter’s fields.
Test Name:

Enter a brief description of the test.

Input Density:

Enter the density of the sample (0.001‐9.999). Use an external measuring
device for the density value in g/cm3. The density is used to calculate the
Kinematic viscosity of the sample.

Percent Solids:

Enter the percent of solids in the sample (0 to 100). This field is for the
operator’s use only. It is not used in any of the calculations.

Temperature:

If the temperature sensor is installed and turned on in the Options Setup,
the word “Auto” will be displayed. If the sensor is turned off in the
Options Setup, enter the temperature of the sample with the Bob
lowered into the Cup. (Temperature unit is setup in
View/Options/System, choices are Kelvin, Celsius (default), and
Fahrenheit.) This data is very important for repeatability and is saved
with the test file.

Operator Name:

Enter the person operating the viscometer.

Sample Name:

Enter the name or code for the sample. This field will be displayed as the
title on graphs and printouts.

User Input:

This field is provided for the operator to write notes or comments about
the test.
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Bob:

Select the Bob that is installed on the viscometer by using the pull‐down
menu. (Click the down arrow for the list of available Bobs.)

Spring Set:

The value can be 25 – 1000. This is used to scale the Standard Hercules
graph. It is represented in kilodynes on the torque axis.

Ramp to Max?:

Max RPM – If you select this option enter the desired maximum RPM (1‐
6600 on standard DV‐10s or 1‐8800 with the upgraded DV‐10s). The DV‐
10 will ramp down or stop after reaching the maximum RPM.
Shear Rate – If you select this option, enter the desired maximum Shear
Rate (1‐27,984 on standard DV‐10s or 1‐37,312 on upgraded DV‐10s). The
DV‐10 will ramp down or stop after reaching the maximum Shear Rate
unless the maximum RPM is reached first.
Max Torque – If you select this option, enter the desired maximum
Torque (1‐18,000 kilodyne‐cm) that should be exerted. The DV‐10 will
ramp down or stop after reaching the maximum Torque unless the
maximum RPM is reached first.
Shear Stress – If you select this option, enter the maximum Shear Stress
(1‐720,000 dynes/cm2) that should be exerted. The DV‐10 will ramp down
or stop after reaching the maximum Shear Stress unless the maximum
RPM is reached first.

After Max:

Ramp Down – By selecting this, the viscometer will ramp down after
reaching the maximum specified in the Ramp to Max.
Stop Immediately – The test will automatically stop when ramped to the
maximum specified in the Ramp to Max.

Pre‐Shear:

Number of times to run the machine with the listed parameters before
running an actual test. It will not produce data when running pre‐shear.

Ramp Time:

Time in seconds for the spindle to ramp up to the maximum RPM and
ramp back down to zero (0.1‐120 seconds). Default ramp time is 20.4
seconds.

Hold Time:

Enter the number of seconds (0‐999) that the test will hold when it has
reached the maximum specified in the Ramp to Max.

3. Click the Run button. This will start the testing process according to the parameters
entered. By default, the Standard Hercules graph (Torque vs. RPM) will be produced while
the viscometer is running.
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GRAPH MENU
Show Graph
Opens a new window displaying another Hercules rheogram, which can be customized. Note:
You must have data before you can create a graph.
1. Select the variables you want to appear on the X (horizontal) and Y (vertical) axes from the
Graph Settings dialog. If you want to create a Standard Hercules graph, check the Standard
Hercules option. Click OK.
Note: If you select the Standard Hercules option, skip the next step; the scaling is
automatic.
2. Select the type of scaling for the graph from the Graph Scale dialog. Click OK.
Auto Scale – Check this to have WinShear32 create an automatic scaling for the
graph.
Log Scale – Check this to use a logarithmic scaling for the graph.
The following fields are available when the Auto Scale option is turned off.
Min – Type the lowest value that you want the graph to display.
Max – Type the highest value that you want the graph to display.
Lines – Type the number of major lines that you want to appear between the
Min and Max values.
Ticks – Type the value that you want each of the smaller divisions along the axes
to represent.

Settings
The tabular menu has all the settings options for the graphs. Click on the graph to make it the
active window before changing settings.

Axis Tab
Displays the current variables on the X and Y axes, and allows you to modify them.
Select the variables you want to appear on the X (horizontal) and Y (vertical) axes from the Axis
dialog. If you want to create a Standard Hercules graph, check the Standard Hercules option.
Click OK.
If you select the Standard Hercules option, skip the next step; the scaling is automatic.
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Scale Tab
Displays the Graph Scale dialog. This will tell you how the X and Y axis are scaled, and allow you
to modify them.
Auto Scale – creates an automatic scaling for the graph.
Log Scale –uses a logarithmic scaling for the graph.
The following fields are available when the Auto Scale option is turned off.
Min – Type the lowest value that you want the graph to display.
Max – Type the highest value that you want the graph to display.
Lines – Type the number of major lines that you want to appear between the Min and
Max values.
Ticks – Type the value that you want each of the smaller divisions along the axes to
represent.

Colors Tab
Displays the Graph Colors dialog. This will tell you the current colors for all graphs, and allow
you to modify them.
Note: These changes can be made at any time and will apply to all graphs (past and future).
1. Select an item from the Graph Colors dialog.
Back Color – color of the area under the grid
Fore Color – color of the grid lines
Desk Color – color of the area outside of the graph, but within the graph window
Text Color – color of the text, including the title, subtitles and labels
Data Color – color of the graph line representing the current data set.
Overlay Colors – color of the overlay lines. The first overlay you add will have the color
specified under #1. The second overlay you add will have the color specified under #2
and so on.
2. Click the Change button.
3. Select a color from the Color dialog and click OK.
4. Click OK on the Graph Colors dialog. Note: The changes will affect all graphs viewed and
created in the current WinShear32 session, not just currently selected graph.

Fonts Tab
Displays the Graph Fonts dialog. This will allow you to change the font for the title, subtitle, and
label of all graphs. Note: These changes can be made at any time and will apply to all graphs
(past and future).
1. In the Graph Fonts dialog, click the Change button next to the type of text you want to
change. You can change the test of the title, subtitle, and labels.

24

2. Select a font and font style in the Font dialog. Click OK. Note: You cannot change the font
size.
3. Click OK on the Graph Fonts dialog. Note: The changes will affect all graphs viewed and
created in the current WinShear32 session, not just the currently selected graph.

General Tab
Note: This can be set at any time and will apply to all graphs.
Line Thickness – change the thickness of the data line only. Options are small, medium or
large. This is often helpful for legible printing of the graph.
Show Direction Markers – shows ramp up and ramp down direction arrows.
Show Grid Lines – displays the grid lines at each variable on the X‐Y axis.

Custom Text Tab
Customize the graph title, subtitle and X‐Y axis text. Note: All of these settings are default to
Auto.
1. Uncheck Auto on the text area you want to change.
2. Type in the text that you want to be displayed on the selected graph heading.

Setup Default Graph
This allows the user to set up 1‐3 different graphs to be displayed after the test has completed.
1. Select any or all of the 3 different graphs to be displayed.
2. Click the Setup Graph # button to open the settings dialog.
3. Select the variables you want to appear on the X (horizontal) and Y (vertical) axes on the
Axis dialog. If you want to create a Standard Hercules graph, check the Standard Hercules
option. Click OK. (If you selected the Standard Hercules, skip the next step; scaling is
automatic.)
4. Select the variables you want to appear on the X (horizontal) and Y (vertical) axes on the
Axis dialog. If you want to create a Standard Hercules graph, check the Standard Hercules
option and skip the next step; the scaling is automatic. Click OK.
5. Select the type of scaling for the graph from the Graph Scale dialog. Click OK.
Auto Scale –creates an automatic scaling for the graph.
Log Scale –uses a logarithmic scaling for the graph.
The following fields are available when the Auto Scale option is turned off.
Min – Type the lowest value that you want the graph to display.
Max – Type the highest value that you want the graph to display.
Lines – Type the number of major lines that you want to appear between the Min and
Max values.
Ticks – Type the value that you want the smaller divisions along the axes to represent.
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DIAGNOSTICS MENU
Terminal
Opens a terminal emulation window. This is used for diagnostic purposes. If you are
experiencing problems with your viscometer a Kaltec technician will instruct you on how to
gather specific information while in terminal mode.

Hardware Diagnostics
This tests many aspects of the DV‐10 for troubleshooting purposes.

Output Channel – Channel 0 displays an amplified torque in the real‐time display. Turning
the cup holder lightly in the counterclockwise direction will change the value rapidly.
Channel 1 is non‐amplified and will not change as rapidly when testing.
RPM – displays the real‐time RPM of the spindle. Turning the spindle shaft by hand in either
direction will change the RPM value, which confirms that it is working.
Torque – displays the Torque in real‐time by turning the cup holder counterclockwise lightly
by hand.
Temperature – displays real‐time temperature, if the temperature sensor option is
installed. This is also used to calibrate the sensor.
Ch0 & Ch1 Gains – values are stored in the viscometer memory for the two torque channels
when the viscometer is calibrated.
Ch0 & Ch1 Torque – snapshot of torque sensor on both channels completely unfiltered. If
either of these values are 0, you will need to contact Kaltec’s Service Department as the
torque sensor may be out of specification.
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Calibrate
Calibrates the DV‐10 to a standard viscosity or a precision weight.
Note:

It is very important that you do not calibrate your machine when you first set it
up. The viscometer was calibrated before it left the factory and will hold for a
long time. Please call Kaltec’s Service Department before any calibration
procedure is conducted.

All Hercules® Hi‐Shear Viscometers are calibrated at the factory and are ready for use at
delivery. However, calibration should be checked periodically (after every 100 tests or monthly)
as outlined in the Operator’s manual. The viscometer should be re‐calibrated only after the
operator has determined it is not in conformance.
Note:

If any error occurs during the calibration procedure, all tests performed
afterwards will be incorrect. Please follow the directions carefully.

To determine whether your viscometer requires calibrating, run the Calibration Check.

Conditioning Sample
Install the Cup into the Cup Holder. Pour the Kaltec Test Fluid into the Cup using a Fluid Depth
Gauge (P/N 10310) up to the “A” Bob mark, or the fill line etched inside the Quick Cup. Install
the “A” Bob on to the Spindle and lower it into the Cup. It is imperative that the Cup, Bob and
Test Fluid are exactly 25°C before running the calibration procedure. Conditioning by use of a
precision constant temperature bath is an acceptable method. Kaltec recommends using a
calibrated microprobe thermocouple (less than 0.018” in diameter) to measure temperature in
the gap. To lower the temperature, use a cold, damp cloth wrapped around the cup. To raise
the temperature, use a hot, damp cloth.
Once the sample is conditioned, simply click the Check Calibration button; the viscometer will
start to run. After the Calibration Check has stopped a window will show the apparent viscosity.
Compare that value with the value on the test fluid bottle. If the value is ±2% from the Kaltec
Test Fluid value, there is no need to calibrate your viscometer. If your value falls outside this
parameter, you need to calibrate by using one of the following methods:
Calibrate by Viscosity
1. Prepare the Standard Test Parameters and condition the sample as mentioned earlier.
2. Enter the Apparent Viscosity value located on the Kaltec Test Fluid bottle. Select Calibrate
Now. It will ask for a password. The spindle will begin to rotate and reach maximum RPM.
3. Once maximum RPM (1100) has been reached, the viscometer will automatically set the
gains from the torque sensor reading. Your viscometer is now calibrated.

28

4. Confirm calibration.
a. Run Calibration Check.
b. After the test is complete, it will display the calculated Apparent Viscosity.
c. Compare the Apparent Viscosity results to the value on the Kaltec Test Fluid
bottle. If the value is within ±2% of the Kaltec Test Fluid value, your viscometer is
calibrated properly.

Calibrate by Weight
To use the Calibrate by Weight option, you must purchase the Calibration Kit.
1.
2.
3.
4.
5.
6.
7.
8.
9.

Remove the Cup and Bob from the viscometer.
Slip the Calibration Ring with the cantilever in front over the Cup Holder.
Install the Calibration Insert into the Cup Holder aligning the slot with the screw.
Wrap the string counterclockwise (top view) once around the Insert just above the hole
located on the back of the Insert. (Do not overlap string.)
Lay string over the pulley on the cantilever allowing the looped end to hang freely. (Do not
hang the weight at this time.)
On the Calibrate by Weight section of the Calibrate dialog, select Calibrate Now. It will ask
for a password.
Wait a few seconds for the next dialog prompt, and then fasten the weight on to the looped
end of the string hanging over the pulley.
Click OK. In a few seconds you should see a prompt; “Calibration Successful.”
Confirm calibration by running the Check Calibration one more time.
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WINDOW MENU
Cascade
Overlaps the windows within the WinShear32 program, beginning in the upper left corner of
the window.

Tile
Arranges the windows within the WinShear32 program side‐by‐side, without overlapping.
The Window menu also has a list of the open windows for the current data file, i.e. graph,
calculations, and so on. By clicking on any of these items (graph, calculations, etc.) will bring it
to the top for better viewing.
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HELP MENU
Contents
Displays the main contents screen of the online help system.

About WinShear32
Displays the WinShear32 copyright screen with the version number.
The System Info button will start the Microsoft System Information program if your computer
supports it. This can help a system administer determine if there is a problem with the
computer.

General Troubleshooting
Problem:
WinShear32 won’t communicate with the DV‐10 (shows communication error).
Solution:
Check all cable connections, DV‐10 power is on, and Emergency Stop button is not
pressed.
Check the comm. Port selection in the Options menu or on the communication error
dialog. Note: Laptops usually use comm port 1, desktop PC’s usually use either 1 or 2.

Problem:
Test won’t start.
Solution:
Check that DV‐10 power is on, Emergency Stop button is not pressed and motor fuse is
not blown. Turn off the DV‐10 for at least 1 minute, turn back on and try running test
again.
Check the settings listed on the Hardware menu.
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Problem:
Blown motor fuse, or
Test stops before it is complete, and there is a horizontal line on the graph.
Solution:
Power off the DV‐10, replace fuse (located next to the power cord) with a 20 amp, 32
volt AGC fuse. If the fuse blows again when power is turned on, then contact Kaltec’s
Service Department.
If it blows during or at the end of a test, you may be running a sample that has exceeded
the limitations of the viscometer. In this case you should set the test parameters as
follows:
o Ramp to Max? = Torque: Set the torque value to the maximum torque required
by the test.
o After Max? = Stop immediately: This will force WinShear32 to stop the test at the
max torque setting and should prevent any more blown fuses.

Problem:
Test runs OK, but there are no results on the graph.
Solution:
Check the settings listed in Hardware. Make sure there is a value near 1000 for the Ch0
and Ch1 gains. If not, then run a calibration. If either of the Ch0 or Ch1 torque readings
are 0, contact Kaltec’s Service Department.
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